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Setting up Word 2013

® Hello and welcome to
Setting up Word 2013.
This short video will walk
you through some of the
changes you may wish to
make to your default
settings of Word before
you begin creating
documents.
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® So now you've been
upgraded to Word 2013,
and while your files were
not affected, several of
your settings and defaults
in Word have probably
changed.
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® Some of this is due to
changes and new features
from Microsoft, and some
of this is due to how the
upgrade process works.
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® Regardless of the reason,
let's now take a look at how
to fix and change some of
the most common default
settings in Word 2013.
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® First, let's change the ’
default font and the default z,
spacing of lines and '
paragraphs for all new
documents.

® Both of these settings are
found in the same location.
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® On the Design tab, in the
Document Formatting
group, click the Paragraph
Spacing button in the
upper right corner, and
then select Custom
Paragraph Spacing at the
bottom of the menu.
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*The M Styles dial
e anage y es Ia Og | Edit |Eecommend | Re;trict| Set Defaults |
. . Fant:
box displays with the Set
P, +Headings . |:|
Defaults tab visible. et
Adobe Caslon Pro Bold 57
Font calor: Automatic E
Paragraph Paosition
Left: o =) Spedial By:
Right: 0 = |[none) E =
Alignment: Left E
Paragraph Spacing
Before: 0 pt =] Line spacing: At
After. 0 pt = |single [~ :
@ Only in this document () New documents based on this template
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o Manage Styles EE
® Near the top of this tab, o T sccommend | s etosout

“A'l,

use the Font and Size e — -
drop-down menus to select s, T
a font and its default point o —————
size. o A o
i .
- [

@ Only in this document

(") New documents based on this template
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[ Manage Styles @Iﬂ

| Edit | Recommend | Re;trict| Set Defaults |

® On the same tab, in the
Paragraph Spacing :
section near the bottom, pashe e "
set the Before and After

spacing to 0 pt, and the

Line Spacing to Single.

Adobe Caslon Pro Bold

Font color: Automatic

Paragraph Paosition
Left:

o

Right: 0

Alignment: Left

Paragraph Spacing
Before: 0 pt =] Line spacing: At

After: 0 pt = | single E

@ Only in this document

Import/Export...

(") New documents based on this template




Setting up Word 2013

s 0
® To make these changes the e

| Edit | Recommend | Re;trict| Set Defaults |

standard default for all new Fi"f 2
ET I - 8 .-

documents, at the bottom oo ! .

of the dialog box, select the | 70, == &
New documents based on o
this template radio button

Befare: 0 pt

and then click OK.

Right: 0

@ Only in this documenfl () Mew documents based on this template I
Import/Export.. 0K | Cancel
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® Now, let's set the default
margins for all new
documents.
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® On the Page Layout tab, in
the Page Setup group,
click the dialog box
expander symbol in the
bottom right-hand corner
of the group.
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® The Page Setup dialog box

displays with the Margins
tab visible.

Multiple pages: Maormal El

Preview

Apply to: | Whole document |Z|

Set As Default
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® You can now change the

margin settings to your

liking, as well as any other — e
settings on any of the other I
tabs in this dialog box. O -

Apply to:
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® Just as before, to make
these changes the default
for all new documents, click
the Set As Default button
in the bottom left-hand
corner of the dialog box,
and then click OK.

Left: 1
Gutt a

Preview

Apply to: | Whole docu

Set As Default

Multiple pages: Morma

nt|Z|
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® Now, let's change three
settings that can all be
found in the same place.
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® Click the File tab, and then
select the Options option
at the bottom of the list.
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® The Word Options dialog
box displays, with the
General tab in view.

Word Options

General
Display
Proofing
Save
Language
Advanced
Customize Ribbon
Quick Access Toolbar
Add-Ins

Trust Center

General options for working with Word.

User Interface options

[7] Show Mini Toalbar on selection &

Enable Live Preview

Update document content while dragging

ScreenTip style: |Show feature descriptions in ScreenTips EI

Personalize your copy of Microsoft Office

User name: Scott A, Concilla

Initials: SAC

[] Always use these values regardless of sign in to Office.
Office Background: | Circuit El

Office Theme: Dark Gray El

Start up options

Choose the extensions you want Word to open
by default: Default Programs...

Tell me if Microsoft Word isn't the default program for viewing and
editing documents,

= Open e-mail attachrments and other uneditable files in reading view "

[] Show the Start screen when this application starts

oK l [ Cancel
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® First, if you don't like the ‘

m i N i -tOO| ba r that d iS p I ays Proofing User Interface options 2

Save | [7] Show Mini Toalbar on selection (i I _
Language =

when you select text in a

ScreenTip style: |Show feature descriptions in ScreenTips EI

E.:i‘ General options for working with Word.

Customize Ribbon

d ocumen t, yo U can d | Sa b I e Quick Access Toolbar || Personalize your copy of Microsoft Office

Add-Ins User name: Scott A, Concilla
® .
It Trust Center Initials: SAC
) [] Always use these values regardless of sign in to Office. <
Office Background: | Circuit El
Office Theme: Dark Gray El

Start up options

Choose the extensions you want Word to open
by default: Default Programs...

Tell me if Microsoft Word isn't the default program for viewing and
editing documents,

[] Open e-mail attachments and other uneditable files in reading view & -

[] Show the Start screen when this application starts

oK l [ Cancel
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® In the User Interface | -

options section at the top, | =~ =

Save | [7] Show Mini Toalbar on selection (i I '
Language =

unc h ecC k t h e S h ow M i n i o Update document content while dragging

ScreenTip style: |Show feature descriptions in ScreenTips EI

E.:i‘ General options for working with Word.

Customize Ribbon

TOOI ba r on Selection Quick Access Toolbar Personalize your copy of Microsoft Office

Add-Ins User name: Scott A, Concilla
(J .
O t I O n Trust Center Initials: SAC
° [] Always use these values regardless of sign in to Office. <
Office Background: | Circuit El
Office Theme: Dark Gray El

Start up options

Choose the extensions you want Word to open
by default: Default Programs...

Tell me if Microsoft Word isn't the default program for viewing and
editing documents,

[] Open e-mail attachments and other uneditable files in reading view & ‘s

[] Show the Start screen when this application starts

oK l [ Cancel
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® Next, Word 2013 has a new | -

Display

E.:i‘ General options for working with Word.

fea t u re t h at O pe n S || Proofing User Interface options “‘J

Save [] Show Mini Toelbar on selection (i

Language Enable Live Preview

unknown documents and

Advanced Update document content while dragging

ScreenTip style: |Show feature descriptions in ScreenTips EI
Customnize Ribbon

atta C h m e nts i n n eW Vi eW Quick Access Toolbar Personalize your copy of Microsoft Office

Add-Ins User name: Scott A, Concilla

Ca”ed Read MOde. You Can Trust Center Initials: SAC

[] Always use these values regardless of sign in to Office.

Office Background: | Circuit El

disab|e this behaVior, Office Theme: Dark Gray [ = |

Start up options

Choose the extensions you want Word to open
by default: Default Programs...

Tell me if Microsoft Word isn't the default program for viewing and
editing documents,

[] Open e-mail attachments and other uneditable files in reading view & @ .

[] Show the Start screen when this application starts

oK l [ Cancel
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®Inthe S U i
n the Start Up options == i
l : E.:i‘ General options for working with Word. ¢

Display ;

section at the bottom, “A;,
Save [7] Show Mini Toalbar on selection & .

o Language Enable Live Preview
u n C h eC k t h e o pe n e ma I I Advanced Update document content while dragging

ScreenTip style: |Show feature descriptions in ScreenTips EI
Customnize Ribbon

attachments and other

Add-Ins User name: Scott A, Concilla

u n ed ita b I e fi I es i n Trust Center Initials: SAC

[] Always use these values regardless of sign in to Office.

Office Background: | Circuit El

reading View Option. Office Theme: Dark Gray [ =

Start up options

Choose the extensions you want Word to open
by default: Default Programs...

Tell me if Microsoft Word isn't the default program for viewing and

] Open e-mail attachrments and other uneditable files in reading view "
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® Lastly Word, as well as all of = -

E.:i‘ General options for working with Word.

Display &
L]
the other Office 2013 | proomns '
o
Save [] Show Mini Toelbar on selection (i -

Language Enable Live Preview

a p p I I Cat I O n S, I n Itl a I Iy Advanced Update document content while dragging

ScreenTip style: |Show feature descriptions in ScreenTips EI
Customnize Ribbon

d i S p | ays a Sta r‘t SC ree n Quick Access Toolbar Personalize your copy of Microsoft Office

Add-Ins User name: Scott A, Concilla
L] L] L]
Trust Cent Initials: SAC
I nStead Of gOI ng d I reCtly to N o 0 Always use these values regardless of sign in to Office,
Office Background: | Circuit El

a blank docu ment. Office Theme: Dark Gray [ v |

Start up options

Choose the extensions you want Word to open
by default: Default Programs...

Tell me if Microsoft Word isn't the default program for viewing and
editing documents,

[] Open e-mail attachments and other uneditable files in reading view & ‘s

[] Show the Start screen when this application starts

oK l [ Cancel
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® If you would like to go = -

- E.:i‘ General options for working with Word.
isplay

directly to a bla n k || Proofing User Interface options w’

Save [] Show Mini Toelbar on selection (i

Language Enable Live Preview

document when starting

ScreenTip style: |Show feature descriptions in ScreenTips EI
Customnize Ribbon

WO rd , u n C h eC k t h e S h ow Quick Access Toolbar Personalize your copy of Microsoft Office

Add-Ins User name: Scott A, Concilla
t h St t h Trust Center Initials: SAC
e a r screen w en 0 Always use these values regardless of sign in to Office,
Office Background: | Circuit El

this application starts el

Start up options

L]
Choose the extensions you want Word to open _
O pt I O n . by default _Default Programs...

Tell me if Microsoft Word isn't the default program for viewing and
editing documents,

= L L L L I - - - ViE‘N T .‘: :
[] Show the Start screen when this application starts g

[ ok || concel |
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® As you're probably aware,
Word has a habit of
changing a lot of things
automatically while you're

typing.
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® And while some of these
“corrections” are very
helpful, some of them are
downright intrusive and
annoying.
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® You should still have the

Display

Word Options dialog box

Save

»

":\/BCJ Change how Word corrects and formats your text. T

rrect options

s EE;:L?\;:‘.:M corrects and formats -
. . . L 1
O pe n I/ I f n Ot, O pe n I t a g a I n o When correcting spelling in Microsoft Office programs

Advanced

Customize Ribbon Ignore words in UPPERCASE

and select the Proofing

Ignore Internet and file addresses
Add-Ins Flag repeated words

ta b Trust Center [] Enforce accented uppercase in French
L]

[T] Suggest from main dictionary only

Custom Dictionaries...

French medes: | Traditional and new spellingsEI

m

Spanish mades: | Tuteo verb forms only EI

When correcting spelling and grammar in Word

Check spelling as you type

[T] Mark gramnmar errors as you type
Frequently confused words y
[] Check grarmmar with spelling

Show readability statistics -
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° . . Word Options [ -
At t h e to p Of th I S SeCt I O n’ General @ Change how Word corrects and formats your text. >
Display

C | i C k t h e Au toco rrect Proofing AutoCorrect options
- . f:;zuage E;;r;g;:fvt;:‘.:rd corrects and formats -
0 pt I O n s b u tto n I n t h e When correcting spelling in Microsoft Office progr;

Advanced

Customize Ribbon Ignore words in UPPERCASE

u p pe r ri g ht corner. ik Ao Tooto Ignore words that contain numbers

Ignore Internet and file addresses
Add-Ins Flag repeated words

Trust Center [] Enforce accented uppercase in French

m

[T] Suggest from main dictionary only

Custom Dictionaries...

French medes: | Traditional and new spellingsEI
Spanish mades: | Tuteo verb forms only EI

When correcting spelling and grammar in Word

Check spelling as you type

[T] Mark gramnmar errors as you type
Frequently confused words :'
[] Check grarmmar with spelling

Show readability statistics -




Setting up Word 2013

The AutoCorrect dialog —_—

AutoCorrect | Math AutoCorrect | AutoFormat As You Type

L]
bOX d I S p I ays Show AutoCorrect Options buttons y
. p;
Correct TWo INitial CApitals —

Capitalize first letter of sentences
Capitalize first letter of table cells
Capitalize names of days

Correct accidental usage of cAPS LOCK key

Replace text as you type
Replace: With: (@ Plain text Formatted text

Automatically use suggestions from the spelling checker

] [ Cancel
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® This dialog box has five
tabs, however right now,
you only need to worry

x
AutoCorrect: English (United 5 S

AutoFormat

Actions

AutoFormat As You Type

AutoCorrect Math AutoCarrect
toCo Options buttons

e TWao INitial CApitals
Capitalize first letter of sentences
Capitalize first letter of table cells
Capitalize names of days

Correct accidental usage of cAPS LOCK key

about the following three
tabs:

® AutoCorrect

Replace text as you type

Replace: With: (@ Plain text Formatted text

® AutoFormat

® AutoFormat As You Type




Setting up Word 2013

® Go through ALL THREE of

these tabs, and deselect

any automatic behaviors,

x
AutoCorrect: English (United 5 S

AutoFormat

Actions

AutoCorrect

to(‘

Math AutoCaorrect

AutoFormat As You Type

ptions buttons

cd

TWo INitial CApitals

Capitalize first letter of sentences
Capitalize first letter of table cells
Capitalize names of days

corrections, or actions that ‘“
Replace text as you type

Replace: With: (@ Plain text Formatted text

you don't want.
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You'll notice that some ——

AutoCorrect Math AutoCorrect | AutoFormat As You Type 5
L]
options appear on more . t .

COWNt TWa INitial CApitals | Exceptions...

Capitalize first letter of sentences

than one tab, hence why it o et

is important to review all Aot
three tabs and make

changes as needed.

Replace text as you type
Replace: With: (@ Plain text Formatted text

Automatically use suggestions from the spelling checker

0K ] [ Cancel
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® Once you're done with this
dialog box, click OK to
close it.

x
AutoCorrect: English (United 5 S

| AutoFormat | Actions

AutoCorrect | Math AutoCorrect | AutoFormat As You Type

Show AutoCorrect Options buttons

Correct TWo INitial CApitals

Capitalize first letter of sentences
Capitalize first letter of table cells
Capitalize names of days

Correct accidental usage of cAPS LOCK key

Replace text as you type
Replace: With: (@ Plain text Formatted text

Automatically use suggestions from the gpelling checker

0K ] [ Cancel
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® We're now done with this

Display
Secti O n’ SO C | iC k O K a g a i n Proofing AutoCorrect options
Save Change how Word corrects and formats '
(] Language teat as you type: =

to C I O Se t h e Wo rd 0 ptl o n s When correcting spelling in Microsoft Office programs

Advanced

-

":\/BCJ Change how Word corrects and formats your text.

Customize Ribbon Ignore words in UPPERCASE

L]
L Ignore words that contain numbers
I a Og OX. Quick Access Toolbar

Ignore Internet and file addresses
Add-Ins Flag repeated words

Trust Center [] Enforce accented uppercase in French

m

[T] Suggest from main dictionary only

Custom Dictionaries...

French medes: | Traditional and new spellingsEI
Spanish mades: | Tuteo verb forms only EI

When correcting spelling and grammar in Word

Check spelling as you type

[T] Mark gramnmar errors as you type
Frequently confused words :'
[] Check grarmmar with spelling

Show readability stat -
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® That covers most of the
basic changes you're
probably going to want to
make before getting
started with Word 2013.
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®If there was something not uppov E————
covered in this video, go to Office help and training -
o - Find helpful answers. Contact real people. Learn simpler ways to work. ;
the Microsoft Office help p T

site at support.office.com

Get help with a product

O R E a

for further information. S S

Top solutions

> Trending topics
> Getting started with Office 2016

> Install, upgrade, and activate

> Office 365 for business
ST T







